
Chapter 1

What Is All This Stuff?
In This Chapter
� Deciding how you can use Excel 2003

� Looking at cell basics

� Starting Excel 2003 from the Start menu or with a desktop shortcut

� Making sense of the Excel 2003 screen

� Getting the lowdown on the Excel 2003 toolbars

� Surfing an Excel 2003 workbook

� Selecting commands from the pull-down menus

� Selecting commands from the shortcut menus

� Getting some help from the Answer Wizard

� Getting the heck out of Excel 2003

Just because electronic spreadsheets like Excel 2003 have become almost
as commonplace on today’s personal computers as word processors and

games doesn’t mean that they’re either well understood or well used. In fact,
I encounter scads of users, even those who are reasonably well versed in the
art of writing and editing in Microsoft Word, who have little or no idea of
what they could or should do with Excel.

This lack of awareness is really a shame — especially in this day and age when
Office 11 seems to be the only software found on the majority of machines
(probably because, together, Windows XP or 2000 and Office 11 hog so much
hard drive space that no room is left to install anybody else’s software). If
you’re one of the folks who has Office 11 on your computer but doesn’t know
a spreadsheet from a bedsheet, this means that Excel 2003 is just sitting there,
taking up a lot of space. Well, it’s high time to change all that.
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What in the World Would 
I Do with Excel?

Excel is a great organizer for all types of data, be they numeric, textual, or
otherwise. Because the program has loads of built-in calculating capabilities,
most people turn to Excel when they need to set up financial spreadsheets.
These spreadsheets tend to be filled to the gills with formulas for computing
stuff, such as total sales, net profits and losses, growth percentages, and
those sorts of things.

Also popular are Excel’s charting capabilities that enable you to create all
types of charts and graphs from the numbers that you crunch in your 
financial worksheets. Excel makes it really easy to turn columns and rows
of boring, black-and-white numbers into colorful and snappy charts and
graphs. You can then use these charts to add some pizzazz to written reports
(like those created with Word 2003) or to punch up overheads used in formal
business presentations (like those created with Microsoft PowerPoint).

Now, even if your job doesn’t involve creating worksheets with a lot of fancy-
Dan financial calculations or lah-di-dah charts, you probably have plenty of
things for which you could and should be using Excel. For instance, you may
have to keep lists of information or maybe even put together tables of infor-
mation for your job. Excel is a great list keeper (even though we tend to refer
to such lists as data lists or databases in Excel) and one heck of a table maker.
Therefore, you can use Excel anytime that you need to keep track of products
that you sell, clients who you service, employees who you oversee, or you
name it.

Little boxes, little boxes . . .
There’s a really good reason why Excel is such a whiz at doing financial 
calculations by formula and keeping lists and tables of information orga-
nized. Look at any blank Excel worksheet (the one in Figure 1-1 will do fine)
and just what do you see? Boxes, lots of little boxes, that’s what! These little
boxes (you can find millions of them in each worksheet that you encounter)
are called cells in spreadsheet jargon. And each piece of information (such as
a name, address, monthly sales figure, or even your Aunt Sally’s birth date)
goes into its own box (cell) in the worksheet that you’re building.

If you’re used to word processing, this idea of entering different types of
information in little, bitty cells can be somewhat strange to get used to. If
you’re thinking in word-processing terms, you need to think of the process of
building an Excel worksheet as being more like setting up a table of informa-
tion in a Word document rather than writing a letter or report.
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Send it to my cell address
As you can see in Figure 1-1, the Excel worksheet contains a frame used to
label the columns and rows. Columns are given letters of the alphabet, and
the rows are numbered. The columns and rows must be labeled because the
Excel worksheet is humongous. (Figure 1-1 shows only a tiny part of the total
worksheet.) The column and row labels act like street signs in a city — they
can help you identify your current location, even if they don’t prevent you
from becoming lost.

Figure 1-1:
Little boxes,
little boxes,

and they 
all look just 

the same!

11Chapter 1: What Is All This Stuff?

Why spreadsheet programs 
produce nothing but worksheets

Spreadsheet programs like Excel 2003 refer to
their electronic sheets as worksheets rather
than spreadsheets. And, although it is perfectly
acceptable (even preferable) to call one of its
electronic sheets a worksheet, you never, never
refer to Excel as a worksheet program — it’s

always called a spreadsheet program. So you
can think of Excel as a spreadsheet program
that produces worksheets, but not as a work-
sheet program that produces spreadsheets. (On
the other hand, I often refer to worksheets as
spreadsheets in this book — and so can you.)
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As shown in Figure 1-2, Excel constantly shows you your current position in
the worksheet in three different ways:

� Look at the current cell reference box of Figure 1-2, where it reads
G9 (upper-left corner). This box, called the Name box, resides on 
the Formula bar, which sits atop the worksheet display. Here, Excel
lists the current cell location by its column (G) and row (9) refer-
ence. (Read more about the so-called A1 cell reference system 
in the sidebar elsewhere in this chapter, “Cell A1, also known 
as Cell R1C1.”)

� In the worksheet itself, the cell pointer (refer to Figure 1-2), shown by a
heavy border, appears in the cell that’s currently selected.

� In the frame of the worksheet, the letter of the column and the number
of the row containing the cell pointer are shaded in a distinct golden
color.

You wonder why Excel makes such a big deal about telling you which cell
is current in the worksheet? That’s a good question, and the answer is 
important:

In the worksheet, you can enter or edit information in only the cell 
that’s current.

The repercussions of this seemingly innocuous little statement are enor-
mous. It means that if you’re paying more attention to what you need to 
enter in your spreadsheet than to which cell is current, you can end up
replacing something you’ve already entered. It also means that you’ll never
be able to edit a particular cell entry if you haven’t first selected the cell to
make it current.
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Cells: The building blocks of all worksheets
The cells in an Excel worksheet are formed by
the intersection of the column and row grid.
Technically, such an arrangement is known as
an array. An array keeps track of different
pieces of information stored in it by referring to
its row position and its column position (some-
thing you see more clearly when I discuss the

R1C1 cell referencing system in the sidebar,
“Cell A1, also known as Cell R1C1,” elsewhere
in this chapter). To display your worksheet data
in its grid and tabular format, Excel just reads
from the row and column position associated
with the data that you enter there.
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So just how many cells are 
we talking about here?
I’m not exaggerating when I say that each worksheet contains millions of
cells, any of which can be filled with information. Each worksheet has 256
columns, of which only the first 9 or 12 (letters A through I or L) are normally
visible in a new worksheet, and 65,536 rows, of which only the first 15 to 25
are normally visible in a new worksheet. If you multiply 256 by 65,536, you
come up with a total of 16,777,216 empty cells in each worksheet you use!
(That’s over 16 million of those suckers!)

And as if that weren’t enough, each new workbook that you start comes
equipped with three of these worksheets, each with its own 16,777,216 blank
cells. This gives you a grand total of 50,331,648 cells at your disposal in any
one Excel file that you happen to have open. And should that number prove
to be too few (yeah, right!), you can add more worksheets (each with its
16,777,216 cells) to the workbook.

Current cell reference Cell pointer

Column letter and row number

Figure 1-2:
Excel shows

you where
you are 

in the
worksheet.
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Assigning 26 letters to 256 columns
When it comes to labeling the 256 columns in a worksheet, our alphabet —
with its measly 26 letters — is not up to the task. To make up the difference,
Excel doubles up the cell letters in the column reference so that column AA
immediately follows column Z. This is followed by column AB, AC, and so on
to AZ. After column AZ, you find column BA, and then BB, BC, and so on.
According to this system for doubling the column letters, the 256th (and last)
column of the worksheet is column IV. This, in turn, gives the very last cell of
any worksheet the cell reference IV65536.

What you should know about 
Excel at this point
Remember the following things about Excel:

� Each Excel file is referred to as a workbook.

� Each new workbook that you open contains three blank 
worksheets.

• Each of these three blank worksheets contains a whole bunch of
cells into which you enter your data.

• Each cell in each of these three worksheets has its own cell
address made up of the letter(s) of its column and the 
number of its row.
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Cell A1, also known as cell R1C1
The A1 cell reference system is a holdover from
the VisiCalc days. (VisiCalc was the granddaddy
of spreadsheet programs for personal comput-
ers.) In addition to the A1 system, Excel sup-
ports a much older, technically more correct
system of cell references: the R1C1 cell refer-
ence system. In this system, both the columns
and rows in the worksheet are numbered, and

the row number precedes the column number.
For example, in this system, cell A1 is called
R1C1 (row 1, column 1); cell A2 is R2C1 (row 2,
column 1); and cell B1 is R1C2 (row 1, column 2).
To switch to the R1C1 system, choose Tools➪
Options on the Excel menu bar and then click
the General tab followed by the R1C1 Reference
Style check box before clicking OK.
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What you still need to know about Excel
You could easily get the mistaken idea that a spreadsheet program like Excel
is little more than a quirky word processor with a gridlock that forces you to
enter your information in tiny, individual cells instead of offering you the spa-
ciousness of full pages.

Well, I’m here to say that Bill Gates didn’t become a billionaire several times
over by selling a quirky word processor. (All you Microsoft Word users out
there, please hold your tongues!) The big difference between the cell of a
worksheet and the pages of a word processor is that each cell offers com-
puting power along with text-editing and formatting capabilities. This com-
puting power takes the form of formulas that you create in various cells of
the worksheet.

Quite unlike a paper spreadsheet, which contains only values computed
somewhere else, an electronic worksheet can store both the formulas and
the computed values returned by these formulas. Even better, your formulas
can use values stored in other cells of the worksheet, and, as I explain in
Chapter 2, Excel automatically updates the computed answer returned by
such a formula anytime that you change these values in the worksheet.

Excel’s computational capabilities, combined with its editing and formatting
capabilities, make the program perfect for generating any kind of document
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More worksheet size trivia
If you were to produce the entire worksheet grid
on paper, you would need a sheet that was
approximately 21 feet wide by 1,365 feet long!
On a 14-inch computer screen at a screen res-
olution of 800 by 600 pixels, you can normally
see no more than between 10 and 12 complete
columns and between 20 and 25 complete rows
of the entire worksheet. With columns being
about 1 inch wide and rows about 1⁄4 inch high,
10 columns represent a scant 3.9 percent of the
total width of the worksheet, while 20 rows fill
only about 0.03 percent of its total length. This
should give you some idea of how little of the
total worksheet is visible on the screen as well
as just how much area is available.

� All spreadsheet information is stored in the
individual cells of the worksheet. You can,
however, enter information into only the cell
that is current (that is, selected with the cell
pointer).

� Excel indicates which of the over 16 million
cells in the worksheet is the current (active)
one by displaying its cell reference on the
formula bar and displaying the cell pointer
in the worksheet itself. (Refer to Figure 1-2.)

� The system for referencing cells in a 
worksheet — the A1 cell reference 
system — combines the column letter(s)
with the row number.
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that uses textual and numeric entries and requires you to perform calculations
on those values. Because you can make your formulas dynamic — so that
their calculations are automatically updated when you change referenced
values stored in other cells of the worksheet — you will find it much easier
to keep the calculated values in a worksheet document both current and 
correct.

Getting the Darn Thing Started
If you’re at all familiar with using Windows XP or 2000, you won’t be shocked
to find out that you have about a zillion ways to get Excel up and running after
the program’s been installed on your hard drive. (Okay, only about half a dozen,
and I’m going to talk about almost all of them.) Suffice it to say at this point
that all the various and sundry methods for starting Excel require that you
have Windows XP or Windows 2000 installed on your personal computer.
(Excel 2003 won’t run under any older Windows versions, such as Windows
95 and 98.) After that, you have only to turn on the computer before you can
use any of the following methods to get Excel 2003 started.

Starting Excel 2003 from 
the Windows Start menu
The most common way to launch Excel is by selecting the program from
the Windows Start menu just as you can do to start any program installed
on your computer. To start Excel 2003 from the Start menu, follow these
simple steps:

1. Click the Start button on the Windows taskbar to open the Windows
Start menu.

2. Highlight All Programs at the top of the Start menu.

3. Click the Microsoft Excel 2003 option on the Programs menu.

As soon as you complete these steps, Windows opens Excel 2003. As the 
program loads, you see the opening screen for Microsoft Excel 2003. When
Excel finishes loading, you are presented with a screen like the one shown in
Figure 1-4, containing a new workbook in which you can begin working.

After launching Excel from the All Programs submenu, Windows goes ahead
and adds Microsoft Excel to the left panel of the Windows Start menu. This
means that the next time you need to launch Excel, all you have to do is click
the Start button on the Windows taskbar and then click Microsoft Excel on
the left side of the Start menu.

16 Part I: Getting In on the Ground Floor 
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Starting Excel 2003 with 
a desktop shortcut
If you use Excel all the time like I do, you won’t want to have to deal with
the Start menu each time you need to launch the program. Instead, you can
create an Excel desktop shortcut that enables you to start the program
simply by double-clicking its icon. If you find that is too much trouble, you
can add the desktop shortcut to the Quick Launch toolbar on the Windows
taskbar. By doing that, you make it possible to launch the program simply by
clicking the Excel button on the Quick Launch toolbar.

To create the Excel desktop shortcut, follow these steps:

1. Click the Start button on the Windows taskbar.

The Start menu opens where you can click the Search item.

2. Click Search in the lower-right corner of the Start menu.

The Search Results dialog box appears.

3. Click the All Files and Folders link in the panel on the left side of the
Search Results dialog box.

The Search Companion pane appears on the left side of the Search
Results dialog box.

4. Type excel.exe in the All or Part of the File Name text box.

Excel.exe is the name of the executable program file that runs Excel.
After finding this file on your hard disk, you can create a desktop short-
cut from it that launches the program.

5. Click the Search button.

Windows now searches your hard disk for the Excel program file. After
locating this file, its name appears on the right side of the Search Results
dialog box. When this filename appears, you can click the Stop button in
the left panel to halt the search

6. Right-click the file icon for the excel.exe file and then highlight Send
To on the pop-up menu and click Desktop (Create Shortcut) on its 
continuation menu.

A shortcut named Shortcut to excel.exe appears to your desktop.

7. Click the Close button in the upper-right corner of the Search Results
dialog box.

After closing the Search Results dialog box, you should see the icon
named Shortcut to excel.exe on the desktop. You should probably
rename the shortcut to something a little more friendly, such as 
Excel 2003.
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8. Right-click the Shortcut to excel.exe icon and then click Rename on
the pop-up menu.

9. Replace the current name by typing a new shortcut name, such as
Excel 2003 and then click anywhere on the desktop.

After creating an Excel desktop shortcut on the desktop, from then on, you
can launch Excel by double-clicking the shortcut icon.

If you want to be able to launch Excel by clicking a single button, drag the
icon for your Excel desktop shortcut to the Quick Launch toolbar to the
immediate right of the Start button at the beginning of the Windows taskbar.
When you position the icon on this toolbar, Windows indicates where the
new Excel button will appear by drawing a black, vertical I-beam in front of or
between the existing buttons on this bar. As soon as you release the mouse
button, Windows adds an Excel 2003 button to the Quick Launch toolbar that
enables you to launch the program by a single-click of its icon.

Figure 1-3 shows my Windows desktop after creating an Excel 2003 desktop
shortcut and adding this shortcut as a button to the Quick Launch toolbar.
Note that Windows does not remove the desktop shortcut at the time you
add it to the Quick Launch toolbar. That way, you have a choice between
using the desktop shortcut (with a double-click) or using the Excel 2003
button on the Quick Launch toolbar (with a single-click).

Mousing Around
Although most of Excel’s capabilities are accessible from the keyboard, in
most cases the mouse is the most efficient way to select a command or per-
form a particular procedure. For that reason alone, if you need to use Excel
regularly in getting your work done, it is well worth your time to master the
program’s various mouse techniques.

Minding your mouse manners
Windows programs, such as Excel, use four basic mouse techniques to select
and manipulate various objects in the program and workbook windows:

� Clicking an object to select it: Positioning the pointer on something and
then pressing and immediately releasing the primary mouse button (the
left button unless, as a leftie, you’ve switched the buttons around).

� Right-clicking an object to display its shortcut menu: Positioning the
pointer on something and then pressing and immediately releasing the
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secondary mouse button (the right button unless, as a leftie, you’ve
switched the buttons around).

� Double-clicking an object to open it: Positioning the pointer on some-
thing and then pressing and immediately releasing the primary mouse
button rapidly twice in a row.

� Dragging an object to move or copy it: Positioning the pointer on 
something and then pressing and holding down the primary mouse
button as you move the mouse in the direction you wish to drag the
object. When you have positioned the object in the desired location
on the screen, you then release the primary mouse button to place it.

When clicking an object to select it, you must make sure that the tip of the
mouse pointer is touching the object that you want to select before you click.
To avoid moving the pointer slightly before you click, grasp the sides of the
mouse between your thumb (on one side) and your ring and little finger (on
the other side), and then click the primary button with your index finger. If
you run out of room on your desktop for moving the mouse, just pick up the
mouse and reposition it on the desk (which does not move the pointer).

Excel 2003 desktop shortcut

Excel 2003 Quick Launch button

Figure 1-3:
To start

Excel, click
the Excel
button on
the Quick

Launch
toolbar or

double-click
its desktop

shortcut.
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Getting your mouse pointer in shape
The shape of the mouse pointer is anything but static in the Excel program.
As you move the mouse pointer to different parts of the Excel screen, the
pointer changes shape to indicate a change in function. 

Don’t confuse the mouse pointer with the cell pointer. The mouse pointer
changes shape as you move it around the screen. The cell pointer always
maintains its shape as an outline around the current cell or cell selection
(whereupon it expands to include all the selected cells). The mouse pointer
responds to any movement of your mouse on the desk and always moves
independently of the cell pointer. You can use the mouse pointer to reposi-
tion the cell pointer, however. You do this by positioning the thick, white
cross pointer in the cell that you want to hold the cell pointer and then 
clicking the primary mouse button.

So What Do All These Buttons Do?
In Figure 1-4, I identify the different parts of the Excel program window that
appear when you first start the program (assuming that you haven’t selected
an existing workbook to open at the same time the program starts). As you
can see, the Excel window, upon opening, is chock-full of all kinds of useful,
though potentially confusing, stuff!

Turning on to the title bar
The first bar in the Excel window is called the title bar because it shows you
the name of the program that is running in the window (Microsoft Excel).

20 Part I: Getting In on the Ground Floor 

When a single click is just as good as a double
Keep in mind that when using Windows XP or
2000, you have the ability to modify the way that
you open icons on the Windows desktop on the
General tab of the Folder Options dialog box
(opened by choosing Tools➪Folder Options on
menu bar of a window, such as My Documents
and My Computer). If you use a single-click to

Open an Item (Point to Select), you can open
programs, such as Excel 2003, along with any of
its folders and files on the desktop and in the My
Computer and Explorer windows by single-
clicking their icons. If this is how your computer
is set up, your double-clicking days are pretty
much over and done!
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When the workbook window is full size (as it is in Figure 1-4), the name of the
workbook file follows Microsoft Excel, as in

Microsoft Excel Enterprise Edition - Book1

To the left of the program and filename on the title bar, you see the Excel icon
(it appears as a green italic L crossed to form an X inside a box). When you
click this icon, the program Control menu opens with all the commands that
enable you to size and move the Excel program window. If you choose the
Close command (the large X in the upper-right corner) on this menu (or
press the shortcut keys, Alt+F4), you exit from Excel and are returned 
to the desktop.

Formula bar

Sheet tab scrolling buttons

Menu bar

Title bar Standard toolbar Formatting toolbar

Close

Restore down

Minimize

Sheet tabs Horizontal scrollbar

Vertical scrollbar

Home task pane

Status bar

Windows XP taskbar

Figure 1-4:
The Excel

program
window

contains a
veritable

smorgas-
bord of

buttons,
toolbars,
and task

panes.
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The buttons on the right side of the title bar are sizing buttons. Click the
Minimize button (the one with the underscore), and the Excel window
shrinks down to a button on the Windows taskbar. Click the Restore Down
button (the one with the image of two smaller, tiled windows), and the Excel
window assumes a somewhat smaller size on the desktop, and the Restore
Down button changes to the Maximize button (the one with a single, full-size
window), which you can use to restore the window to its original full size. If
you click the Close button (the one with an X), you exit Excel (just as if you
choose Close on the Control menu or press Alt+F4).

Messing around with the menu bar
The second bar in the Excel window is the menu bar. This bar contains the
Excel pull-down menus, File through Help. You use these menus to select the
Excel commands that you need to select when creating or editing your work-
sheets. (Jump ahead to the section “Ordering Directly from the Menus” for
more information on how to select commands.)

To the left of the pull-down menus, you see an Excel file icon. When you click
this icon, the file Control menu (much like the program Control menu) opens,
showing all the commands that enable you to size and move the Excel work-
book window (which fits within the Excel program window). Choose the Close
command on this menu (or press the shortcut keys, Ctrl+W or Ctrl+F4), and
you close the current Excel workbook without exiting the Excel program.

To the right of the pull-down menus, you see the Ask a Question drop-down
text box. You can use this box to ask the Excel Answer Wizard any question
you have about using Excel 2003. When you enter a new question in the Ask
a Question box, Excel displays a list of possibly relevant help topics beneath
the text box. Clicking one of these topics automatically opens the Excel Help
window (see “Ogling the Online Help,” later in this chapter, for details).

The sizing buttons on the right side of the menu bar do the same thing to
the current workbook window as the sizing buttons on the title bar do to the
Excel program window. Click the Minimize Window button, and the Excel
workbook window shrinks down to a tiny workbook title bar at the bottom
of the workbook area. Click the Restore Window button, and the current
workbook window assumes a somewhat smaller size on the workbook area.
The Excel workbook icon, filename, and file-sizing buttons move to the title
bar of this somewhat smaller workbook window; and the Restore Window
button changes to the Maximize button, which you can use to restore the
window to its original full size. If you click the Close button (the one with
the X), you close the current workbook file (just as if you choose Close
on the file Control menu or press Ctrl+W or Ctrl+F4).

Excel 2003 automatically adds a button to the Windows taskbar for each
workbook file that you open in Excel 2003. This nifty new feature makes it

22 Part I: Getting In on the Ground Floor 

d537563 Ch01.qxd  9/2/03  10:40 AM  Page 22



super-easy to switch between workbooks. When you minimize the Excel pro-
gram with the program’s Minimize Window button, a button displaying the
name of the current workbook is added to the taskbar.

Scrutinizing the Standard 
and Formatting toolbars
The third bar in Excel 2003 stacks the two most popular Excel toolbars,
Standard and Formatting, side by side. These two toolbars contain buttons
(also known as tools) for doing the most common tasks that you perform in
Excel. Tools on the Standard toolbar include those for doing really basic file-
type stuff such as creating, saving, opening, and printing workbooks. Tools
on the Formatting toolbar include those for manipulating appearance-type
stuff, such as selecting a new font and font size and adding effects such as
boldface, underlining, and italics to worksheet text.

To identify the function of any of the tools on these two (or any other) toolbars,
simply position the arrowhead mouse pointer over the button until a tiny text
box (called a ScreenTip) appears below the mouse pointer. To have Excel exe-
cute the command associated with a particular tool, simply click the button
under the mouse pointer.

Because the Standard and Formatting toolbars each contain a whole bunch
of tools, not all the buttons in either toolbar can be displayed together on
the third bar of the Excel screen. This is why the last tool on each of these
two toolbars, the Toolbar Options button (indicated by a downward-pointing
black triangle), has the continuation symbol (>>) over it. The presence of
this symbol immediately tells you that the toolbar is truncated in some way
and that not all of its buttons are displayed.
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Stack ’em up
If you prefer to have immediate access to all the
buttons on the Standard and Formatting tool-
bars at all times, you can do so easily by stack-
ing the two toolbars one on top of the other,
rather than side by side. (This is the way that
these two toolbars appeared in all three previ-
ous versions of Excel for Windows). To make
this change, right-click somewhere on the
menu bar or third bar with the two toolbars, and

then select the Customize command at the very
bottom of the shortcut menu that pops up. Doing
this opens the Customize dialog box from which
you click the Options tab. Click the first check
box option on the Options tab labeled Show
Standard and Formatting Toolbars
On Two Rows to add a check mark. I promise:
You’ll never have need for the Toolbar Options
button again.

d537563 Ch01.qxd  9/2/03  10:40 AM  Page 23



When you click the Toolbar Options button, Excel displays a palette with the
additional tools that don’t fit on the toolbar when it’s stacked side-by-side
with another toolbar. At the bottom of the palette of additional tools, you find
two commands:

� Show Buttons on Two Rows: Click this to display the Standard and
Formatting toolbars on separate rows.

� Add or Remove Buttons: This command comes with a pop-up button
that enables you to customize which buttons appear on either the
Standard or Formatting toolbars.

When you select the Add or Remove Buttons item on the Toolbar Options
pop-up menu, Excel displays another pop-up menu from which you can select
the Standard or Formatting toolbar. After selecting Standard or Formatting
from this submenu, yet another pop-up menu appears, this one showing all
the buttons associated with the particular toolbar (Standard or Formatting)
that you selected. All the buttons currently displayed on the particular tool-
bar have check marks in front of them. To add buttons to the toolbar from
this menu, click the tool in question to precede it with a check mark. To tem-
porarily remove one of the buttons on the toolbar, click the button to remove
its check mark. (For detailed information on customizing the buttons on
these and other Excel toolbars, see Chapter 12.)

In Table 1-1, you can see the name and function of each tool normally found
on the Standard toolbar when you first install Excel 2003. In Table 1-2, I list
the name and function of each tool usually found on the Formatting toolbar.
Rest assured: You will come to know each one intimately as your experience
with Excel grows.

Table 1-1 The Cool Tools on the Standard Toolbar
Tool Tool Name What the Tool Does When You Click It

New Opens a new workbook with three blank
worksheets.

Open Opens an existing Excel workbook.

Save Saves changes in the active workbook.

Permission Lists the current permission settings on the
current workbook and enables you to set or
change these permissions.

E-mail Opens an e-mail message header for send-
ing the worksheet to someone via the
Internet.

24 Part I: Getting In on the Ground Floor 

d537563 Ch01.qxd  9/2/03  10:40 AM  Page 24



Tool Tool Name What the Tool Does When You Click It

Print Prints the workbook.

Print Preview Previews how the worksheet will appear
when printed.

Spelling Checks the spelling of spreadsheet text.

Research Opens the Research task pane where you
can search for online information. 

Cut Cuts the current selection from the work-
sheet and places it into the Clipboard as a
prelude to pasting it elsewhere.

Copy Copies the current selection to the
Clipboard.

Paste Pastes the current contents of the Clipboard
into your worksheet.

Format Painter Applies all the formatting used in the current
cell to any cell selection that you choose.

Undo Undoes your last action.

Redo Repeats your last action.

Insert Hyperlink Enables you to insert a hypertext link to
another file, Internet address (URL), or spe-
cific location in another document. (See
Chapter 10 for information on using
hyperlinks.)

AutoSum Adds, averages, counts, or finds the highest
or lowest value in the current selection of
cells or enables you to select some other
Excel function.

Sort Ascending Sorts data in a cell selection in alphabetical
and/or numerical order, depending upon the
type of data in the cells.

Sort Descending Sorts data in a cell selection in reverse
alphabetical and/or numerical order,
depending upon the type of data in the cells.

(continued)
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Table 1-1 (continued)
Tool Tool Name What the Tool Does When You Click It

ChartWizard Walks you through the creation of a new
chart in the active worksheet. (See Chapter
8 for details.)

Drawing Displays and hides the Drawing toolbar,
which enables you to draw various shapes
and arrows. (See Chapter 8 for details.)

Zoom Changes the screen magnification to zoom
in or out on your worksheet data.

Microsoft Excel Help Displays the Microsoft Excel task pane on
the right side of the screen from which you
can use the Answer Wizard to search for
help or look up particular topics to get help
on using various Excel features. (See
“Ogling the Online Help,” later in this 
chapter, for details.)

Table 1-2 The Cool Tools on the Formatting Toolbar
Tool Tool Name What the Tool Does When You Click It

Font Applies a new font to the entries in the
cell selection.

Font Size Applies a new font size to the entries in
the cell selection.

Bold Applies bold to or removes bold from
the cell selection.

Italic Applies italics to or removes italics
from the cell selection.

Underline Underlines the entries in the cell selec-
tion (not the cells); if the entries are
already underlined, clicking this tool
removes the underlining.

Align Left Left-aligns the entries in the cell 
selection.

Center Centers the entries in the cell selection.
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Tool Tool Name What the Tool Does When You Click It

Align Right Right-aligns the entries in the cell
selection.

Merge and Center Centers the entry in the active cell
across selected columns by merging
their cells into one.

Currency Style Applies a Currency number format to
the cell selection to display all values
with a dollar sign, with commas
between thousands, and two decimal
places.

Percent Style Applies a Percentage number format to
the cell selection; the values are multi-
plied by 100 and displayed with a per-
cent sign and no decimal places.

Comma Style Applies a Comma number format to the
cell selection to display commas sepa-
rating thousands and adds two decimal
places.

Increase Decimal Adds one decimal place to the number
format in the cell selection each time
that you click the tool; reverses direc-
tion and reduces the number of deci-
mal places when you hold down the
Shift key while you click this tool.

Decrease Decimal Reduces one decimal place from the
number format in the cell selection
each time that you click the tool;
reverses direction and adds one 
decimal place when you hold down
the Shift key as you click this tool.

Decrease Indent Outdents the entry in the current cell to
the left by one character width of the
standard font.

Increase Indent Indents the entry in the current cell to
the right by one character width of the
standard font.

Borders Selects a border for the cell selection
from the pop-up palette of border
styles.

(continued)
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Table 1-2 (continued)
Tool Tool Name What the Tool Does When You Click It

Fill Color Selects a new color for the back-
ground of the cells in the cell selection
from the pop-up color palette.

Font Color Selects a new color for the text in the
cells in the cell selection from the pop-
up color palette.

Toolbar Options Displays a pop-up menu with a menu
item that enables you to show the
Standard and Formatting toolbars on
two rows (if they currently share one)
or one row (if they currently inhabit a
single row each) and an item for
adding and removing buttons. If the
toolbar is truncated (indicated by the
addition of >> to this button), this 
pop-up menu contains a palette
with all the tools that can’t currently 
be displayed on the toolbar.

Fumbling around the Formula bar
The Formula bar displays the cell address and the contents of the current
cell. This bar is divided into three sections:

� Name box: The left-most section that displays the address of the current
cell address

� Formula bar buttons: The second, middle section that is shaded and
contains the Name box drop-down button on the left and the Insert
Function button (labeled fx) on the right

� Cell contents: The third, right-most white area that takes up the rest of
the bar

If the current cell is empty, the third cell contents section of the formula bar is
blank. As soon as you begin typing an entry or building a worksheet formula,
the second and third sections of the formula bar come alive. As soon as you
type a character, the Cancel and Enter buttons appear in the shaded Formula
bar buttons section (see Figure 1-5). These buttons appear in between the
Name box drop-down button (which automatically changes into a Functions
drop-down button whenever you edit a cell containing a formula) and the
Insert Function button. (See Chapter 2 for information on using these buttons.)
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After the Insert Function button, you see the characters that you typed in the
cell contents section of the Formula bar, mirroring the characters that appear
in the worksheet cell itself. After you complete the entry in the cell — by
clicking the Enter button — Excel displays the entire entry or formula in the
Formula bar, and the Enter and Cancel buttons disappear from the Formula
bar buttons section. The contents that you enter into any cell thereafter
always appear in the Formula bar whenever you position the cell pointer in
that cell of the worksheet.

Winding your way through 
the workbook window
A blank Excel workbook appears in a workbook window right below the
Formula bar when you first start the program (assuming that you don’t start
it by double-clicking an Excel workbook icon) accompanied by the New

Insert Function button

Enter button

Cancel button

Name box or Functions drop-down button

Name box

Figure 1-5:
Cancel 

and Enter
buttons

appear on
the Formula

bar between
the Name
box drop-

down button
and the

Insert
Function

button when
you type a
cell entry.
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Workbook task pane to its right. As you can see in Figure 1-6, when you click
the Restore Window button to make the workbook window less than full size,
the workbook appears in its own space to the left of the Home task pane.
This workbook window also has its own Control menu (accessed by clicking
the Excel file icon), title bar, and sizing buttons. Its title bar also displays the
workbook filename. (This appears as a temporary filename, such as Book1,
and then Book2 when you open your next new workbook, and so on, until
you save the file the first time.)

On the bottom of the workbook window, you see sheet tab scrolling buttons,
then the sheet tabs for activating the various worksheets in your workbook
(remember that each new Excel workbook has three new sheets to start), fol-
lowed by the horizontal scroll bar that you can use to bring new columns of
the current worksheet into view. On the right side of the workbook window,
you see a vertical scroll bar that you can use to bring new rows of the current
worksheet into view (keeping in mind that you’re only viewing a small percent-
age of the total columns and rows in each worksheet). At the intersection of
the horizontal and vertical scroll bars, in the lower-right corner, you find a
size box, which you can use to manually modify the size and shape of the
less-than-maximized workbook window.

When you start Excel, you can immediately begin creating a new spreadsheet
in Sheet1 of the Book1 workbook that appears in the maximized workbook
window. To separate the workbook’s title bar as well as the Control menu, and
sizing buttons from the Excel menu bar, you click the Restore Window button
on the menu bar. Doing this reduces the workbook window just enough to get
all this stuff on its own workbook title bar as shown in Figure 1-6.

Manually manipulating the workbook window
When you’re working with a less-than-maximized workbook window (like the
one shown in Figure 1-6), you can manually size and move the window with
the sizing box that appears in the lower-right corner at the intersection of the
horizontal and vertical scroll bars.

To manipulate the size of a workbook window, position the mouse pointer 
on this sizing box, and then, when the mouse pointer changes shape to a
double-headed arrow, drag the mouse as needed to adjust the size of the
side or sides of the window. Note that the mouse pointer does not change to
a double-headed arrow unless you position it on the edge of the window (that
is, somewhere on the corner). While the pointer is positioned within the box,
it retains its arrowhead shape.

� If you position the pointer on the bottom side of the window and then
drag the pointer straight up, the workbook window becomes shorter. If
you drag the pointer straight down, the window becomes longer.

� If you position the pointer on the right side of the window and then drag
the pointer straight to the left, the workbook window becomes narrower;
if you drag straight to the right, the window becomes wider.
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� If you position the pointer on the lower-right corner of the window and
then drag the pointer diagonally toward the upper-left corner, the work-
book window becomes both shorter and narrower; if you drag diagonally
away from the upper-left corner, it becomes longer and wider.

When the outline of the workbook window reaches the desired size, you then
release the primary mouse button, and Excel redraws the workbook window
to your new size.

After using the size button to change the size and shape of a workbook window,
you must use the size button again and manually restore the window to its
original shape and dimensions. Unfortunately, Excel has no magic Restore
button available that you can click to automatically restore the workbook
window that you changed.

Control menu

Sheet tab scrolling buttons

Workbook title bar Close

Maximize

Minimize

Size box

Scroll arrows

Scrollbars

Active sheet

Sheet tab

Figure 1-6:
Each Excel
workbook

contains its
own Control

menu and
scrolling

and sizing
buttons.
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Besides resizing workbook windows, you can also move them around within
the area between the Formula bar and status bar in the Excel program
window.

To move a workbook window:

1. Simply pick it up by the scruff of its neck — which, in this case, 
corresponds to the workbook window’s title bar.

2. After you have it by the title bar, drag it to the desired position and
release the primary mouse button.

If you are experiencing difficulty in dragging objects with the mouse, you can
also move a workbook window by following these steps:

1. Click the Excel file icon on the workbook window’s title bar to open
its Control menu and then select the Move command or press Ctrl+F7.

The mouse pointer changes shape from the normal thick, white-cross
pointer to a pointer with crossed, double-headed arrows.

2. Drag the window with the arrowheads cross-hair pointer or press the
arrow keys on the cursor keypad (←, ↑, →, or ↓) to move the work-
book window into the desired position.
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Musical toolbars!
Don’t get too used to the button arrangement
that you experience when first using the
Standard or Formatting toolbars. Excel 2003
uses the intelli-(non)-sense feature whereby the
program automatically keeps promoting the
button that you last used to a higher position on
the toolbar. For instance, if you use a button on
the Toolbar Options palette, the button is imme-
diately added to the regularly displayed portion
of the toolbar. Excel 2003 banishes one of the
unused buttons that appears near the end of
the toolbar onto the Toolbar Options palette. The
end result is musical toolbars wherein you can
never be sure where a needed button will
appear (or not appear if it happens to be exiled
temporarily to the Toolbar Options palette)!

Unfortunately, Excel 2003 doesn’t give you an
option for fixing the position of the buttons on

the toolbars so that you can always tell where a
needed button appears. You can, however,
restore the original arrangement of the buttons
on the toolbars (as well as the commands on the
menus) by right-clicking somewhere on the
menu bar or the bar with the Standard and
Formatting toolbars and then selecting the
Customize command on the shortcut menu that
appears. Doing this opens the Customize dialog
box from which you select the Options tab. Click
the Reset Menu and Toolbar Usage Data button
on the Options tab. Excel then displays an alert
box indicating that the record of the commands
you’ve selected in Excel is about to be deleted.
Click the Yes button, and the program restores
the buttons on your toolbars (and the com-
mands on your menus) to their previous order.
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3. Press Enter to set the workbook window into position.

The mouse pointer returns to its normal thick, white-cross shape.

Slipping through the sheets
At the very bottom of the Excel workbook window that contains the horizontal
scroll bar, you see the sheet tab scrolling buttons followed by the sheet tabs
for the three worksheets in the workbook. Excel shows which worksheet is
active by displaying its sheet tab on top in white as part of the displayed work-
sheet (rather than belonging to unseen worksheets below) with its sheet name
in boldface type. To activate a new worksheet (thus bringing it to the top and
displaying its information in the workbook window), you click its sheet tab.

If you add more sheet tabs to your workbook (see Chapter 7 for details on
how to add more worksheets to your workbook) and the sheet tab for the
worksheet that you want is not displayed, use the sheet tab scrolling buttons
to bring the worksheet into view. Click the buttons with the black triangles
pointing left and right to scroll one worksheet at a time in either direction
(left to scroll left, and right to scroll right). Click the buttons with the black
triangles pointing left and right to the vertical lines to scroll the sheets so
that the tabs for the very first or very last worksheets display at the bottom.

Scoping out the status bar
The bar at the very bottom of the Excel program window is called the status
bar because it displays information that keeps you informed of the current
state of Excel. The left part of the status bar displays messages indicating the
state of the current activity you’re undertaking in the program. When you
first start Excel, the message Ready (far lower-left corner) displays in this
area (as shown in Figure 1-7), telling you that the program is ready to accept
your next entry or command.

The right side of the status bar contains various boxes that display different
indicators telling you when you’ve placed Excel in a particular state that some-
how affects how you work with the program. For example, normally, when
you first start Excel, the Num Lock indicator shows NUM in this part of the
status bar. If you press the Caps Lock key to enter text in all uppercase let-
ters, CAPS appears to the left of NUM. Press the Scroll Lock key (so as to be
able to scroll through the worksheet with the arrow keys), and SCRL appears
to its right.

You AutoCalculate my totals
The widest box (the second one from the left) in the status bar contains the
AutoCalculate indicator. You can use the AutoCalculate indicator to get a 
running total of any group of values in your worksheet. (See the beginning
of Chapter 3 if you need information on how to select groups of cells in a
worksheet.) For example, in Figure 1-7 you see a typical spreadsheet after

33Chapter 1: What Is All This Stuff?

d537563 Ch01.qxd  9/2/03  10:40 AM  Page 33



selecting part of a column of cells, many of which contain values. The total of
all the values in the cells that are currently selected in this worksheet auto-
matically appears in the AutoCalculate indicator on the status bar.

Not only does the AutoCalculate indicator on the status bar give you the sum
of the values in the cells you currently have selected, but the indicator can
also give you other statistics, such as the count or the average of these values.
All you have to do is right-click the AutoCalculate indicator to display its
shortcut menu and then choose from among the following options:

� To get the average of the values in the current cell selection, you select
Average from this indicator’s shortcut menu.

� To get the count of all the cells that contain values (cells containing text
entries are not counted), select Count Nums from this indicator’s short-
cut menu.

� To get the count of all the cells that are selected regardless of what type
of data they contain, select Count from the indicator’s shortcut menu.

� To have the highest value in the cell selection displayed in the
AutoCalculate indicator, choose Max from the indicator’s shortcut 
menu. To have the lowest value displayed, choose Min.

� To have no calculations appear in this area of the status bar, choose
None at the top of this shortcut menu.

� To return the AutoCalculate indicator to its normal totaling function,
choose Sum on the indicator’s shortcut menu.

The Num Lock indicator and the numeric keypad
The NUM in the Num Lock indicator tells you that you can use the numbers on
the numeric keypad to enter values in the worksheet. When you press the Num
Lock key, NUM disappears from the Num Lock indicator. This is your signal
that the cursor-movement functions that also are assigned to this keypad are
now in effect. This means, for instance, that pressing 6 moves the cell pointer
one cell to the right instead of entering this value in the formula bar!

Taming the Excel 2003 task panes
When you first launch Excel with a blank workbook, Excel 2003 automatically
opens the Getting Started task pane to the immediate right of the workbook
(as shown earlier in Figure 1-4). You can use this task pane to edit recently
opened workbooks or to create other new workbooks (see Chapter 2 for
details). Along with the Getting Started task pane, Excel 2003 supports a
fair number of other task panes including a Help, Search Results, Clip Art,
Research, Clipboard, and New Workbook along with more specialized task
panes such as the Template Help, Shared Workspace, Document Actions,
Document Updates, and XML Structure task panes.
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You can turn off the display of any Excel task pane by pressing Ctrl+F1 or by
clicking its Close box located in the upper right-hand corner of its window. If
you close the Task pane when working in Excel (so as to maximize the number
of cells displayed on your computer screen), it remains closed until you press
Ctrl+F1 again or choose the View➪Task Pane or View➪Toolbars➪Task Pane
command on the Excel menu bar.

When a task pane is displayed, you can select the type of task pane that you
want open by clicking the drop-down button on to the immediate left of the
task pane Close box and then selecting the type of pane to use. After select-
ing a new type of task pane, you can scroll between the different task pane
choices by clicking the Previous and Next buttons (marked by a left and right
arrow icon, respectively). To immediately return to the Getting Started task
pane, click the Home button (the one with house icon).

If you decide that you don’t want the Getting Started task pane to automati-
cally be displayed each time that you start up Excel, you can turn off this 
feature by removing (deselecting) the check mark in the Startup Task Pane
check box on the View tab of the Options dialog box that you open by 
choosing Tools➪Options from the Excel menu bar.

Program status indicator AutoCalculate indicator

Caps, Numbers, and Scroll Lock indicators

Figure 1-7:
The sum 

of the
values in 
the cells
currently
selected
automa-

tically
appears
in Auto-

Calculate
indicator 

on the
status bar.

35Chapter 1: What Is All This Stuff?

d537563 Ch01.qxd  9/2/03  10:40 AM  Page 35



You Gotta Get Me out of This Cell!
Excel provides several methods for getting around each of the huge work-
sheets in your workbook. One of the easiest ways is to click the tab for the
sheet that you want to work with, and then use the scroll bars in the work-
book window to bring new parts of this worksheet into view. In addition, the
program provides a wide range of keystrokes that you can use not only to
move a new part of the worksheet into view but also to make a new cell
active by placing the cell pointer in it.

The secrets of scrolling
To understand how scrolling works in Excel, imagine the worksheet as a
humongous papyrus scroll attached to rollers on the left and right. To bring
into view a new section of a papyrus worksheet that is hidden on the right,
you crank the left roller until the section with the cells that you want to see
appears. Likewise, to scroll into view a new section of the worksheet that is
hidden on the left, you would crank the right roller until that section of cells
appears.

Calling up new columns with the horizontal scroll bar
You can use the horizontal scroll bar to scroll back and forth through the
columns of a worksheet. To scroll new columns into view from the right, you
click the right-arrow scroll button on the horizontal scroll bar. To scroll new
columns into view from the left (anytime except when column A is the first
column displayed), you click the left-arrow scroll button.

To scroll very quickly through columns in one direction or the other, you
click the appropriate arrow scroll button in the scroll bar and continue to
hold down the mouse button until the columns that you want to see display
on the screen. As you scroll to the right in this manner, the horizontal scroll
box (that big shaded box between the left- and right-arrow scroll buttons in
the scroll bar) becomes increasingly smaller — it gets really teeny if you
scroll really far right to columns in the hinterland, such as column BA. If you
then click and hold down the left-arrow scroll button to scroll quickly back
through columns to the left, notice that the horizontal scroll box becomes
increasingly larger, until it takes up most of the scroll bar when you finally
display column A again.

You can use the scroll box in the horizontal scroll bar to make big jumps to
the left and right in the columns of the worksheet. Simply drag the scroll box
in the appropriate direction along the bar.
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Raising up new rows with the vertical scroll bar
Use the vertical scroll bar to scroll up and down through the rows of a work-
sheet. To scroll to new rows below those currently in view, you click the down-
arrow scroll button on the vertical scroll bar. To scroll back up to rows above
that are no longer in view (anytime except when row 1 is the first one dis-
played), you click the up-arrow scroll button.

To scroll very quickly through rows in one direction or the other, you click
and hold down the appropriate arrow scroll button in the vertical scroll bar
just as you do in the horizontal scroll bar. As you scroll down the rows with
the down-arrow scroll button, the vertical scroll box (that big shaded box
between the up- and down-arrow scroll buttons in the scroll bar) becomes
increasingly smaller and smaller — it gets really teeny if you scroll way down
to rows 100 and higher. If you then click and hold down the up-arrow scroll
button to scroll quickly back up through the rows, notice that the vertical
scroll box becomes increasingly larger, until it takes up most of the scroll bar
when you finally display row 1 again.

You can use the vertical scroll box to make big jumps up and down the 
rows of the worksheet by dragging the vertical scroll box in the appropriate
direction along the bar.

Scrolling from screen to screen
You can use the horizontal and vertical scroll bars to scroll through the
columns and rows of your worksheet one screen at a time. To do this, you
click the light gray area of the scroll bar not occupied by the scroll box or
the arrow scroll buttons. For example, to scroll to the right by one screen
of columns when the scroll box is snug against the left-arrow scroll button,
you simply click the light gray area of the scroll bar behind the scroll box,
between it and the right-arrow scroll button. Then, to scroll back to the left
by one screen of columns, you click the light gray area in front of the scroll
box, between it and the left-arrow scroll button.

Likewise, to scroll up and down the rows of the worksheet one screen at a
time, you click the light gray area either above or below the vertical scroll
box, between it and the appropriate arrow scroll button.

The keys to moving the cell pointer
The only disadvantage to using the scroll bars to move around is that the
scroll bars bring only new parts of the worksheet into view — they don’t
actually change the position of the cell pointer. If you want to start making
entries in the cells in a new area of the worksheet, you still have to remember
to select the cell (by clicking it) or the group of cells (by dragging through
them) where you want the data to appear before you begin entering the data.
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Excel offers a wide variety of keystrokes for moving the cell pointer to a
new cell. When you use one of these keystrokes, the program automatically
scrolls a new part of the worksheet into view, if this is required to move the
cell pointer. In Table 1-3, I summarize these keystrokes and how far each one
moves the cell pointer from its starting position.

Note: In the case of those keystrokes listed in Table 1-3 that use arrow keys,
you must either use the arrows on the cursor keypad or else have the Num
Lock disengaged on the numeric keypad of your keyboard. If you try to use
these arrow keys to move around the worksheet when Num Lock is on (indi-
cated by the appearance of NUM on the status bar), you either get numbers
in the current cell or nothing happens at all (and then you’ll blame me)!

Table 1-3 Keystrokes for Moving the Cell Pointer
Keystroke in Question Where the Cell Pointer Moves

→ or Tab Cell to the immediate right.

← or Shift+Tab Cell to the immediate left.

↑ Cell up one row.

↓ Cell down one row.

Home Cell in Column A of the current row.

Ctrl+Home First cell (A1) of the worksheet.

Ctrl+End or End, Home Cell in the worksheet at the intersection of the last
column that has any data in it and the last row that has
any data in it (that is, the last cell of the so-called active
area of the worksheet).

PgUp Cell one screenful up in the same column.

PgDn Cell one screenful down in the same column.

Ctrl+→ or End, → First occupied cell to the right in the same row that is
either preceded or followed by a blank cell. If no cell is
occupied, the pointer goes to the cell at the very end of
the row.

Ctrl+← or End, ← First occupied cell to the left in the same row that is
either preceded or followed by a blank cell. If no cell is
occupied, the pointer goes to the cell at the very begin-
ning of the row.

Ctrl+↑ or End, ↑ First occupied cell above in the same column that is
either preceded or followed by a blank cell. If no cell is
occupied, the pointer goes to the cell at the very top of
the column.
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Keystroke in Question Where the Cell Pointer Moves

Ctrl+↓ or End, ↓ First occupied cell below in the same column that is
either preceded or followed by a blank cell. If no cell is
occupied, the pointer goes to the cell at the very bottom
of the column.

Ctrl+PgDn Last occupied cell in the next worksheet of that
workbook.

Ctrl+PgUp Last occupied cell in the previous worksheet of that
workbook.

Block moves
The keystrokes that combine the Ctrl or End key with an arrow key listed in
Table 1-3 are among the most helpful for moving quickly from one edge to
the other in large tables of cell entries or in moving from table to table in a
section of the worksheet that contains many blocks of cells.

� If the cell pointer is positioned on a blank cell somewhere to the left of
a table of cell entries that you want to view, pressing Ctrl+→ moves the
cell pointer to the first cell entry at the leftmost edge of the table (in the
same row, of course).

� When you then press Ctrl+→ a second time, the cell pointer moves to
the last cell entry at the rightmost edge (assuming that no blank cells
are in that row of the table).

� If you switch direction and press Ctrl+↑, Excel moves right to the last
cell entry at the bottom edge of the table (again assuming that there
are no blank cells below in that column of the table).

� If, when the cell pointer is at the bottom of the table, you press Ctrl+↑
again, Excel moves the pointer to the first entry at the top of the next
table located below (assuming that no other cell entries are above this
table in the same column).

� If you press Ctrl or End and arrow key combinations and there are no
more occupied cells in the direction of the arrow key you select, Excel
advances the cell pointer right to the cell at the very edge of the work-
sheet in that direction.

� If the cell pointer is located in cell C15 and no more occupied cells are in
row 15, when you press Ctrl+→, Excel moves the cell pointer to cell IV15
at the rightmost edge of the worksheet.

� If you are in cell C15, there are no more entries below in Column C, and
you press Ctrl+↑, Excel moves the pointer to cell C65536 at the very
bottom edge of the worksheet.
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When you use Ctrl and an arrow key to move from edge to edge in a table or
between tables in a worksheet, you hold down Ctrl while you press one of the
four arrow keys (indicated by the + symbol in keystrokes, such as Ctrl+→).

When you use End and an arrow-key alternative, you must press and then
release the End key before you press the arrow key (indicated by the comma
in keystrokes, such as End, →). Pressing and releasing the End key causes
the END indicator to appear on the status bar. This is your sign that Excel is
ready for you to press one of the four arrow keys.

Because you can keep the Ctrl key depressed as you press the different arrow
keys that you need to use, the Ctrl-plus-arrow-key method provides a more
fluid method for navigating blocks of cells than the End-then-arrow-key
method.

When you gotta go to that cell right now!
Excel’s Go To feature provides an easy method for moving directly to a dis-
tant cell in the worksheet. To use this feature, you display the Go To dialog
box by choosing Edit➪Go To from the Excel menu bar or by pressing Ctrl+G
or the function key, F5. Then, in the Go To dialog box, you type the address of
the cell that you want to go to in the Reference text box and click OK or press
Enter. When typing in the cell address in the Reference text box, you can type
the column letter or letters in uppercase or lowercase letters.

When you use the Go To feature to move the cell pointer, Excel remembers
the references of the last four cells that you visited. These cell references
then appear in the Go To list box. Notice that the address of the cell you
last visited is also listed in the Reference box. This makes it possible to move
quickly from your present location to your previous location in a worksheet
by pressing F5 and Enter (provided that you used the Go To feature to move
to your present position).

Lotsa luck with Scroll Lock
You can use the Scroll Lock key to “freeze” the position of the cell pointer in
the worksheet so that you can scroll new areas of the worksheet in view with
keystrokes such as PgUp (Page Up) and PgDn (Page Down) without changing
the cell pointer’s original position (in essence, making these keystrokes work
in the same manner as the scroll bars).

After engaging Scroll Lock, when you scroll the worksheet with the keyboard,
Excel does not select a new cell while it brings a new section of the work-
sheet into view. To “unfreeze” the cell pointer when scrolling the worksheet
via the keyboard, you just press the Scroll Lock key again.
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Ordering Directly from the Menus
For those occasions when the Excel Standard and Formatting toolbars don’t
provide you with a ready-made tool for getting a particular task done, you have
to turn to the program’s system of menu commands. Excel exhibits a little bit
of menu overkill because, in addition to the regular pull-down menus found on
the menu bar of nearly all Windows applications, the program also offers a sec-
ondary system of shortcut (also sometimes known as context) menus.

Shortcut menus offer fast access to just those menu commands normally used
to manipulate the particular screen object that the menu is attached to (such
as a toolbar, workbook window, or worksheet cell). As a result, shortcut menus
often bring together commands that are otherwise found on several individual
pull-down menus on the menu bar.

Penetrating the pull-down menus
Like when moving the cell pointer in the worksheet, Excel offers you a choice
of using the mouse or the keyboard to select commands from the menu bar.
To open a pull-down menu with the mouse, you simply click the menu name
on the command bar. To open a pull-down menu with the keyboard, you hold
down the Alt key while you type the letter that is underlined in the menu
name (also known as the command letter). For instance, if you press Alt and,
as you hold it down, then press E (abbreviated Alt+E), Excel opens the Edit
menu because the E is underlined.

Alternatively, you can press and release the Alt key or function key F10 to
access the menu bar, and then press the → key until you highlight the
menu that you want to open. Then, to open the menu, you press the ↓ key.

After you open your pull-down menu, you can select any of its commands by
clicking the command with the mouse; pressing the underlined letter in the
command name; or by pressing the ↓ key until you highlight the command,
and then pressing the Enter key.

As you learn the Excel commands, you can combine opening a menu and
selecting one of its menu commands. Click the menu and drag the pointer
down the open menu until you highlight the desired command; then you
release the mouse button. You can accomplish the same thing with the key-
board by holding down the Alt key while you type the command letters for
both the pull-down menu and its command. To close the active workbook
window by choosing the Close command on the File menu, you simply press
Alt, and then type FC.

Some commands on the Excel pull-down menus have shortcut keystrokes
assigned to them (shown after the command on the pull-down menu). You
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can use the shortcut keystrokes to select the desired command instead of
having to access the pull-down menus. For example, to save changes to your
workbook, you press the shortcut keys Ctrl+S instead of having to select the
Save command from the File pull-down menu.

Many commands on the pull-down menus lead to the display of a dialog box,
which contains further commands and options (see “Digging Those Dialog
Boxes,” later in this chapter). You can tell which commands on a pull-down
menu lead to dialog boxes because the command name is followed by three
periods (known as an ellipsis). For example, you know that selecting the File➪
Save As command from the pull-down menu opens a dialog box because the
command is listed as Save As... on the File menu.

Also, note that pull-down menu commands are not always available. You can
tell when a command is not currently available because the command name
is in light gray (or dimmed) on the pull-down menu. A command on a pull-
down menu remains dimmed until the conditions under which it operates
exist in your document. For example, the Paste command on the Edit menu
remains dimmed as long as the Clipboard is empty. But as soon as you move
or copy some information into the Clipboard with the Cut or Copy commands
on the Edit menu, the Paste option is no longer dimmed and appears in normal
bold type when you open the Edit menu — indicating, of course, that this
command is now available for your use.

Now you see ’em, now you don’t
The pull-down menus in Excel 2003 don’t always appear the same way each
time you access them. Thanks to another Microsoft intelli-(non)-sense feature,
normally when you first open a menu, it appears in a truncated form with
some of its commands missing. This “short” form of the menu is supposed to
contain just those commands that you recently used, leaving out those that
you haven’t used in a while. Note that you can always tell when a menu has
been shortened by the appearance of a continuation button (marked by two
Vs, one on top of the other, creating a kind of downward-pointing arrow) at
the very bottom.

If you have the time and patience to do nothing for a few seconds other
than continue to display a shortened menu, Excel automatically replaces
the shortened menu with the complete (unexpurgated) version. If you have
neither the time nor the patience to wait, you can force Excel to display the
entire menu’s offerings by clicking the Expand button that appears with
two downward pointing arrows one on top of the other at the bottom of the
menu list.

When the full menu appears, the left border (where icons for some of the
commands appear) for the previously missing menu items appear on the
complete menu in a darker shade of gray than is applied to the previously

42 Part I: Getting In on the Ground Floor 

d537563 Ch01.qxd  9/2/03  10:40 AM  Page 42



displayed items. This lets you tell at a glance which menu items were newly
added to the full-blown menu. It does not, however, help you in locating the
new positions of the menu items that show up on both the “short” and “long”
versions of the menu because many items are displaced by the addition of
the newly displayed items!

If you, like me, have no desire to play hide-and-seek with the Excel pull-
down menus, you can turn off this “nifty” new feature by taking the 
following steps:

1. Right-click somewhere on the menu bar or the bar with the Standard
and Formatting toolbars to open the shortcut menu.

2. Select the Customize command on the shortcut menu to open the
Customize dialog box.

The Customize dialog box opens.

3. Select the Options tab of the Customize dialog box.

On the Options tab, the check box reading Always Show Full Menus is
not checked (the Show Full Menus after a Short Delay box is
checked by default).

4. Select the Always Show Full Menus check box.

As soon as you select the Always Show Full Menus check box, Excel
automatically removes the check mark from the Show Full Menus
After a Short Delay check box below and dims it to make it cur-
rently unavailable.

5. Click the Close button in the Customize dialog box to close it.

When you’re really new to Excel, I highly suggest turning on the Always
Show Full Menus option so that you don’t keep losing the menu items
you do use because the ones you don’t use are not displayed until after a
short wait.

Note: If you like playing hide-and-seek with the pull-down menus but care
nothing for having the full menus automatically appear after a few seconds
pause, you can disable this feature by removing the check mark from the
check box labeled Show Full Menus After a Short Delay. This check
box is located immediately below the Always Show Full Menus check box
and is operational only when the Always Show Full Menus box is
unchecked.

When changing these types of Personalized Menus and Toolbars settings on
the Options tab of the Customize dialog box in Excel 2003, keep in mind that
your changes equally affect the toolbars and pull-down menus in every
Office 11 program installed on your computer, such as Word 2003 and
PowerPoint 2003.
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Comprehending shortcut menus
Unlike the pull-down menus, which you can access either with the mouse or
the keyboard, you must use the mouse to open shortcut menus and select
their commands. Because shortcut menus are attached to particular objects
on the screen — such as a workbook window, toolbar, or worksheet cell —
Excel uses the secondary mouse button (that is, the right button for right-
handers and the left button for lefties) to open shortcut menus. (And because
you right-handers far outnumber us lefties, this mouse technique has come
to be known as right-clicking an object.)

In Figure 1-8, you can see the shortcut menu attached to the Excel tool-
bars. To open this menu, position the mouse pointer somewhere on the 
toolbar and click the secondary mouse button. Be sure that you don’t 
click the primary button, or you’ll end up activating the tool that the 
pointer is on!

After you open the Toolbar shortcut menu, you can use its commands to dis-
play or hide any of the built-in toolbars or to customize the toolbars. (See
Chapter 12 for details.)

Figure 1-8:
The toolbar

shortcut
menu

appears
when you

right-click a
toolbar.
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In Figure 1-9, check out the shortcut menu attached to any of the cells in
a worksheet. To open this menu, position the pointer on any one of 
the cells and click the secondary mouse button. Note: You can also 
open this shortcut menu and apply its commands to the group of cells 
that you have selected. (You find out how to make cell selections in 
Chapter 3.)

Because the commands on shortcut menus contain command letters, 
you can select one of their commands either by dragging down to the 
command and then clicking it either with the primary or secondary mouse
button or by typing the underlined letter to select it. Otherwise, you can
press the ↓ or ↑ key until you highlight the command; then press Enter to
select it.

The one shortcut menu that you can open with the keyboard is the 
shortcut menu attached to cells in a worksheet. To open this shortcut 
menu in the very upper-right corner of the current cell, you press 
Shift+F10. Note that this keystroke works for any type of Excel sheet 
except a chart, which doesn’t have this type of shortcut menu 
attached to it.

Figure 1-9:
The work-
sheet cell

shortcut
menu

appears
when you

press
Shift+10 
or right-

click a cell.
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Digging Those Dialog Boxes
Many an Excel command is attached to a dialog box that presents you with a
variety of options that you can apply to the command. View the Save As and
Options dialog boxes in Figures 1-10 and 1-11. Between these two dialog
boxes, you can find almost all the different types of buttons, tabs, and boxes
used by Excel in Table 1-4.

Table 1-4 The Parts of a Dialog Box
Button or Box in Question What It’s Good For

Tab Provides a means of displaying a certain set of
options in a complex dialog box like the Options
dialog box (shown in Figure 1-11), bringing together a
whole mess of different types of program settings
that you can change.

Text box (or Edit box) Provides a place for typing a new entry. Many edit
boxes contain default entries that you can alter or
replace entirely.

Text box with Spinner button

Standard text box

Combo box

Figure 1-10:
The General

tab of the
Options

dialog box
contains
standard

text boxes,
text boxes

with spinner
buttons,

along with 
a couple 

of combo
boxes.
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Button or Box in Question What It’s Good For

List box Provides a list of options from which you choose. If
the list box contains more options than can be dis-
played in its box, the list box contains a scroll bar that
you can use to bring new options into view. Some list
boxes are attached to a text box, enabling you to
make a new entry in the text box either by typing it or
by selecting it in the related list box.

Combo box (or drop-down Provides a condensed version of a standard list box 
list box) that, instead of displaying several options in its list,

shows only the current option (which originally is
also the default option). To open the combo box and
display the other options, you click the drop-down
button that accompanies the box. After the list is dis-
played, you can select a new option from it as you
would in any standard list box.

Check box Presents a dialog box option that you can turn on or
off. When the check box has a check mark in it, you
know that its option is selected. When a check box is
blank, you know that its option is not selected.

Radio (or Option) button Presents items that have mutually exclusive options.
The radio or option button consists of a circle fol-
lowed by the named option. These buttons are
always arranged in groups, and only one of the but-
tons in the group can be selected at one time. Excel
lets you know which option is currently selected by
placing a dot in the middle of its circle. (When an
option button is selected, it looks like a knob on an
old-fashioned radio, thus the name radio button.)

Spinner buttons Spinner buttons appear as a pair of small boxes one
atop the other. The spinner button on the top has an
upward-pointing arrowhead on it, whereas the spin-
ner button on the bottom has a downward-pointing
arrowhead on it. You use the spinner buttons to scroll
up and down through a series of preset options as
you select the one you want.

Command button Initiates an action. The command button is rectangu-
lar in shape, and the name of the command displays
within the button. If a name in a command button is
followed by an ellipsis (...), Excel displays another
dialog box containing even more options when you
select the button.
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Note: Although you can move a dialog box out of the way of some data in
your worksheet, you cannot change the box’s size or shape — these 
dimensions are permanently fixed by the program.

Many dialog boxes contain default options or entries that are automati-
cally selected unless you make new choices before you close the 
dialog box.

� To close a dialog box and put your selections into effect, click the OK
button or the Close button (some boxes lack an OK button).

� If the OK button is surrounded by a dark border, which is very often
the case, you can also press Enter to put your selections into 
effect.

� To close a dialog box without putting your selections into effect, you can
either click the Cancel or Close button (the one with the X) in the dialog
box, or simply press Esc.

Most dialog boxes group related options together as an item. (Often, this is
done by placing a box around the options.) When making selections in a
dialog box with the mouse, you simply click the selection that you want to
use or, in the case of text entries, click the pointer in the entry to set the
insertion point and then modify the entry.

Radio or Option button

Drop-down list box

Check box

Command button

Figure 1-11:
The View
tab of the

Options
dialog box

offers a
wide array

of check
boxes, radio
buttons, and

command
buttons.
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When making selections with the keyboard, however, you must sometimes
first activate the item before you can select any of its options.

� Press the Tab key until you activate one of the options in the item.
(Shift+Tab activates the previous item.)

� When you press Tab (or Shift+Tab), Excel indicates which option is 
activated either by highlighting the default entry or by placing a dotted
line around the name of the option.

� After activating an option, you can change its setting either by pressing
↑ or ↓ (this works with sets of radio buttons or options in a list or 
drop-down list boxes), pressing the space bar (this works to select and
deselect check boxes), or by typing a new entry (used in text boxes).

You can also select an option by pressing Alt and then typing the underlined
(command) letter in the option or item name.

� By pressing Alt and typing the command letter of a text box option, you
select the entry in that text box (which you can then replace by typing
the new entry).

� By pressing Alt and typing the command letter of a check box option,
you can select or deselect the option (by adding or removing its check
mark).

� By pressing Alt and typing the command letter of a radio button, you
can select the option while at the same time deselecting whatever radio
button was previously current.

� By pressing Alt and typing the command letter of a command button,
you either initiate the command or display another dialog box.

In addition to the more elaborate dialog boxes shown in Figures 1-10 and 1-11,
you also encounter a simpler type of dialog box used to display messages
and warnings. These dialog boxes are appropriately known as alert boxes.
Many dialog boxes of this type contain just an OK button that you must click
to close the dialog box after reading the message.

Ogling the Online Help
You can get online help with Excel 2003 anytime that you need it while using
the program. The only problem with the traditional online Help system is that
it is only truly helpful when you are familiar with the Excel jargon. If you don’t
know what Excel calls a particular feature, you’ll have trouble locating it in
the Help topics (just like trying to look up in a dictionary a word that you
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have no idea how to spell). To help alleviate this problem, Excel makes use of
the Answer Wizard to enable you to search for information on Microsoft’s
Web site. In your own words, you can type in a question about how to do
something in Excel. The Answer Wizard then attempts to translate your 
question, phrased in perfectly good English, into its horrible Excel techno-
babble so that it can then display the Help topics that give you the informa-
tion you need.

Ask Mr. Answer Wizard
The Answer Wizard enables you to ask questions in plain English about using
Excel. You can access the Answer Wizard in the Ask a Question combo box
on the right side of the menu bar or in the Search text box in the Microsoft
Excel Help task pane (opened by pressing F1).

For example, to search for information on printing a worksheet, you can 
type the question How do I print a worksheet? in the Search text box in the
Microsoft Excel Help task pane and then click the Start Searching button (the
green button with the right arrow to the immediate right) as shown in Figure
1-12. The Answer Wizard responds by displaying a list of printing-related
topics similar to those shown in Figure 1-13.

Figure 1-12:
To get help
on a topic,
enter your

question in
the Search
text box in

the Help
task pane
and then
click the

Start
Searching

button.
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To explore one of the listed topics, click its Page-with-a-Question-Mark icon
or its descriptive text (note that it becomes underlined, like a Web hyperlink,
as soon as you position the mouse pointer anywhere over its text). The
Answer Wizard then opens the Microsoft Excel Help window similar to the
one shown in Figure 1-14. This Help window contains a number of bulleted
headings related to the topic that you select (the bullets appearing in the
form of right-pointing triangles). You can expand each heading to displays its
information by clicking the topic heading or its triangular bullet.

As soon as you click a heading or its bullet, its information displays below
the heading (and the triangular bullet that precedes the heading points
downward instead of to the right). As you read through the help text, you
may come across other bulleted subheadings. To expand these and display
their information, click their bullets or their heading text.

To expand all headings with a particular help topic, click the Show All link
near the top of the Microsoft Excel Help window. To display all the text 
displayed beneath expanded headings across the entire computer screen,
click the Microsoft Excel Help window’s Maximize button. To obtain a print-
out of the help information that you’re viewing, click the Print button (the
one bearing the printer icon) beneath the window’s title bar.

Figure 1-13:
Click a 

topic in 
the Search

Results, and
the Answer

Wizard
opens the
Microsoft

Help
window.
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After you’re done exploring the help topics in the Microsoft Excel Help window,
click the Help window’s Close button. As soon as you close the Help window,
Excel 2003 automatically expands to fill up the space previously taken by this
window. You can then close the Microsoft Excel Help task pane by pressing
Ctrl+F1.

Talking to Clippit
You can personalize the Answer Wizard in the form of Clippit, the animated
paperclip. To make Clippit appear, choose Help➪Show the Office Assistant.

Once visible, you can activate Clippit to ask it a question about using Excel
by clicking its icon. Doing this displays a cartoon bubble above Clippit’s
head, containing a text box where you type your question.

You then type your keywords or question in this text box and then press
Enter or click his Search button, Excel then opens the Search Results task
pane with a list of possibly relevant topics (just like the list that appears
when you use the Ask a Question text box on the menu bar or the Search

Figure 1-14:
Viewing 

the selec-
ted help

topic in the
Microsoft

Help
window.
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text box in the Microsoft Excel Help task pane). As soon as you click a topic
in Search Results list, the Microsoft Help window appears to the immediate
right of the Microsoft Excel Help task pane.

Even after you close the Help window after perusing the relevant help topics,
Clippit remains on the screen. Note that the biggest problem with using Clippit
is that it often obscures the Excel Help task pane and Help window if you keep
it anywhere on the right side of the Excel screen, requiring you to drag its
sorry paperclip out of the way before you can actually get to the help that
you so dearly seek.

To get rid of Clippit, you have to choose Help➪Hide Office Assistant on the
Excel menu bar or right-click his icon and then choose Hide on the shortcut
menu. (If I were you, I would stick to the Ask a Question or Search text box
and skip Clippit altogether.)

Using the Table of Contents
If you have access to the Internet as you work in Excel, you can also look up
help information topically in the Table of Contents. To download this infor-
mation and make use of it, follow these steps:

1. Press F1.

Excel opens the Microsoft Excel Help task pane.

2. Click the Table of Contents link immediately below the Search
text box.

Excel connects you to the Microsoft Web site and downloads the Table
of Contents for Excel 2003.

3. Click the book icon for the main topic you want to explore.

Excel expands the topic by downloading pages of information related
to the main topic.

4. Click the link for the page of information you want to view.

Excel downloads the help information into the Microsoft Help window
that appears to the immediate right of the Microsoft Excel Help task
pane.

5. (Optional) To display all of the information on the selected topic, click
the Maximize button in the Help window and, if necessary, the Show
All button.

6. (Optional) To print the help topic, click the Print button on the Help
window’s toolbar.
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When you finish reading or printing the information in the Help window,
you select another topic in the Excel Help task pane or close the Help
window.

7. To close the Help window, click the Close button in its upper-right
corner.

Excel resizes its own window to take up the missing space. You can then
close the Microsoft Excel Help task pane by pressing Ctrl+F1.

When It’s Time to Make Your Exit
When you’re ready to call it a day and quit Excel, you have several choices
for shutting down the program:

� Click the Close button on the Excel program window.

� Choose the File➪Exit command from the pull-down menus.

� Double-click the Control menu button on the Excel program window (the
green icon with the italic L crossed to form an X in a box that is the very
first thing that appears on the title bar in the very upper-left corner of
the screen).

� Press Alt+F4.

If you try to exit Excel after working on a workbook and you haven’t saved
your latest changes, the program beeps at you and displays an alert box
querying whether you want to save your changes. To save your changes
before exiting, click the Yes command button. (For detailed information on
saving documents, see Chapter 2.) If you’ve just been playing around in the
worksheet and don’t want to save your changes, you can abandon the docu-
ment by clicking the No button.
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